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Overview of this Manual:

Torchmate CAD is an easy to use Computer Aided Design software package designed for use
with Torchmate CNC systems. Torchmate CAD includes many features that are designed for plasma
cutting including nesting, DXF importing, kerf compensation, cut order, lead in / out creation, and
scanned image editing just to name a few. This manual gives a general overview of what Torchmate
CAD’s capabilities are. When teaching a computer program that is designed to create almost anything
that can be imagined there is a certain amount of information that will inevitably be left out. It is
impossible and pretentious to assume that a manual could encompass the entire scope of every item that
could be created with Torchmate CAD. Likewise for some processes or designs there can be multiple
ways to complete the same goal, in cases like this each way may be presented. This manual is a growing
walkthrough that started with questions from phone and email, led to simple walkthroughs, and now a
cohesive document that outlines the operation of Torchmate CAD. As such any suggestions for new
methods, sections, or design ideas are always welcome. Remember Torchmate technical support is free
and unlimited if there are any questions that arise from this manual please do not hesitate to contact us.

Thank you for purchasing Torchmate CAD, welcome to the world of CNC tables and computer design.

Torchmate Technical Support
866-571-1066 x3
775-673-2200 x3

support@torchmate.com




Installing Torchmate CAD:

To begin installation of Torchmate CAD insert the Torchmate CAD CD packaged with a security dongle.
The installer will automatically launch. The first prompt will be to select the setup language. This
language is only for the installer, Torchmate CAD menus are only in English.

Choose Setup Language

Select the language for the inztallation from
the choices below.

[English

After selecting a language the installer will issue a reminder about inserting the security dongle. Follow
the instructions for the specific dongle being used.

InstallShield Wizard

USB Flash Dongle

If your package includes either
a Kingston or Orange-colored
dongle, then please connect it
now. Windows will automatically
detect the device, and you can
then click Next to continue.

If your package includes a Blue-
colored dongle, then please
connect it at the end of your
product install.

Cancel |:

InstallShieid




If a “License File Query’ screen appears the dongle has not been read yet or was inserted too soon. If
using an orange dongle the license files will be on the dongle which will appear as a removable media. If
a blue or purple dongle is being used the license files will be on the installation CD.

License File Queny

Pleaze inzert the Licenze Disk inta your COD ROM diive or
enter the comect path below and presz 0K o conbinue.

Path:
|E:"-. |[ Browse. .. ]
InztallS hield

[ Ok ][ Canicel ]

Continue with the installation.

Torchmate CAD Setup

Welcome to the InstallShield Wizard for Torchmate CAD

The Ihz will install Torchmate CAD on pour computer. To continue, .

Cancel

InstallShieid ' _ <Back H




Torchmate CAD Setup

License Agreement
=

CADLIME LICEMSE AGREEMENT

‘f'ou should carefully read the following terms and conditions before continuing with

the inzstallation of this software program from CADlink Technology Corporation,

[CAD k). If pou do nat agree with these terms, you should return the software and
accompanying security device within & business days of receipt and your money will be
refunded. In consideration of payment of the license fee which iz part of the price you
paid for this product, CADlink provides thiz software and licenses its use; you assume
responaibility for the selection of the software to achieve your intended results, and for
the installation. use, and results obtained from the softyare.

MOTE: A security device accompanies and is specifically dedicated ta the software
purchased by you and iz required ta be inztalled on your computer at all times during
uze of the program to ensure proper operation af the software. If the security device iz
lost. stolen or damaged by whatever means, a replacement security device dedicated to
a replacement software program must be repurchazed at CADInK's then curent
publizhed price.

LICEMSE:

r'ou may:
1. Uge the Software only on a gingle computer and then only render it operational

InstallSi

< Back H Mest » ] Cancel |

Torchmate CAD Setup

Choose Destination Location

Cancel

InstallSi

|




When prompted select ‘Full Install’.

Torchmate CAD Setup

Select Features

Installs

y including the

< Back ﬂ Mest »

1 Cancel

Torchmate CAD Setup

Select Program Folder
F

Install i

Securty - EMBASSY Trust Suite by Wave Systems
Solidw/orks 2006 SPO.0

Solidw/orks 2008

Solidw/orks 2009

Startup

Torchmate

Torchrate 2

Torchmate

der name,

< Back ﬂ Mest »

Cancel




Torchmate CAD Setup

Setup Status

Tarch 40 figuring your

L

>

InstallShield

After the main CAD program is installed the installer will want to search for all fonts installed on the
computer. This is not necessary to run Torchmate CAD but allows all fonts installed on the computer to
be accessed by Torchmate CAD.

Font Installation

Welcome to the Torchmate Font Installation \wizard. To use a font in
Torchmate. it must be installed.

Clicking Continue will start the installation of TrueT ype fonts, CADlnk
WEF fonts, Corel 'WFM fonts and Adobe Type 1 fants.




Torchmate CAD Setup

InstallShield Wizard Complete

Femove a om their d and then click

w @ No, | will restart my computer later.
@5
T

¢ Back H Firish | Caricel [

InstallShield

Torchmate CAD is now ready for use; if a purple or blue security dongle is being used insert it after the
computer has restarted.

****IMPORTANT CONFIGURATION CHANGE****

It is necessary to change one default setting to allow simpler tool path creation. Go to ‘Options’>
"Torchmate Setup’ - “Tool Path Preferences’. Uncheck the option to ‘Group tool paths with originals’.

Tool Path Preferences |§|

30 Chisel
" Single cut
& Double cut

I~ Group tool paths with ariginals

v fpply separately

Cancel |




Overview of Menus:

All functions of Torchmate CAD are accessed from the main screen. The largest feature of the main
screen is the work area; this section contains a gridded work area that is skirted by a material blank. The
main work area is where all drawing will be done. Around the work area are various tool bars that
contain all of the tools, shortcuts, and options for creating a drawing.

Al; \
:i“_...-—- Rulers

al¥ "
': Program Menus  Shortcut Bar Information Bar

/Tool Pallet

Layer Color Pallet
Sheet Layer

Sheet Selection

i

'C]Ei!IHmNilﬂlﬁﬂﬂﬂEEEHEHBEEIIIE#EEEEH.HDEEEUHEEBBE DGR EERFSOEEEEE

By 1

Rulers: The rulers sit on either side of the work area and provide a reference to the coordinates of a spot
in the work area.

Layer Color Pallet: This bar allows the color of an object to be changed; this is useful in keeping track
of various parts. The color of an object does not affect the cutting process at all and in most cases this is
an unused tab. Colors can be changed by double clicking on one of the colors, this opens a window to
change the color options.

Sheet Layer: The sheet layer is a guide used to differentiate multiple sheets of multiple objects. This bar
like the “Layer Color Pallet’ does not affect the cutting process and is generally unused. The sheet layer is
visible when “‘Show Fill’ is enabled in the ‘View’ menu, by default it is transparent.

Sheet Selection: This option is used to toggle between multiple sheets. Multiple sheets occur when
nesting or other options that will create additional sheets. This option enables these sheets to be paged
through if multiple sheets exist.

Shortcut Bar: The shortcut bar contains icons that serve the same function as certain options in the
program menus. Generally these options are for selections that are used frequently. This menu can be
customized by going to ‘View’ - “Toolbars’ - ‘Customize...” various functions can be added or
removed from the bar.
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Information Bar: The information bar contains basic information about a selected object. This bar
contains two main areas, the objects tab and the variable tab. The objects tab gives two bits of
information, the coordinates of the pointer in the grid and how many and what type of objects are
selected. This bar is useful when determining what is selected and also if what is selected is the correct
object. The variable tab is a dynamic bar that will change with each tool and part selected. This bar
displays options for various tools when they are selected.

Objects Tab

Objects: 0 ij wi 00000 | 1000000 2 e oo P
|[: 253,36 415) = ae 00000 Wm jlz% !
Variable Tab

Tool Pallet: The bar on the left hand side of Torchmate CAD contains the pull out menus for basic
drawing tools as well as the means to manipulate them. Each tool will be further explained throughout
this manual but essentially any drawing from scratch will start here.

Measure Tools --.__*__E“"___ Select Tool

A —1extTools
Zoom Tools =——=q
@-—\\/eld Tools

ShapeTools =4 o \ode EditTool

ScanTools =——>»x

Tool Path Tools i—-(—Flll & Stroke Tool
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Navigation and Selection Methods:

Being able to move around the drawing area and manipulate objects is the key to successful drawing. In

Torchmate CAD there are a few ways to simplify this process so that drawing can be done more
efficiently.

Moving around the work area is done in a few ways. The scroll bars along the bottom and right of the
area can be used to pan the page. Another way is to use click the third mouse button this brings up a pan
hand that allows click and drag movement. On most computer mice the third mouse button will activate

when the scroll wheel is depressed.

L] Torehmate CAD - Lintitied! €00 [
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The pan tool can also be accessed in the ‘Zoom Tools” menu. Also in the ‘Zoom Tools’ menu are ways to
either zoom in or out. There are short cuts to all of these or they can be accessed from the menu.

aeagides -

Zoom Shortcuts:

Zoom In: F5

Zoom Out: F6

Zoom to selected Object: F7
Zoom to Material: F8

Pan State: 3" Mouse Button
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Selection of objects can be crucial for certain drawing methods in Torchmate CAD. There are multiple
ways to select an object. With pressing the *TAB’ key will select one object, pressing ‘“TAB’ repeatedly
will cycle through each object generally in the order they were created. A single object can also be
selected simply by clicking on the edge of the object. To ensure that the object is gets selected the mouse
will change into a crosshair when it is over the edge.
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Multiple objects can be selected as well, the simplest way to do this is to click and drag with the
‘Selection Tool” around the objects that are to be selected. Multiple objects can also be selected by using
the ‘Shift” key. With this method begin by selecting one object then hold down *Shift’ on the keyboard;
click on another object both objects will now be selected. This method also works in reverse for
unselecting a single object when multiple objects are selected.

L] Torchmate CAD - Lintithed1 €18
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When selecting multiple objects it can sometimes become ambiguous as to which ones are selected and
which are not. In Torchmate CAD there is a feature that when enabled highlights each selected object a
certain color. This allows for easy identification of selected objects. To enable this feature go to
‘Options’ > Torchmate Setup’ - ’Selection Tool Settings’.

L] Torchmate CAD - Lintitled1 10
Fa 8 Layot Aeacge Machre Trarsfom Ieage

Ehcra®op>ry

L]« »
ale] v »

ADEEEDEER RO TR ER A OFEOEEE ORI EEEE P EIDREEE

Check the box labeled ‘Highlight selected objects’ the ‘Color picker next to this option adjusts the color.

Selection Settings f'5_<|

V' Use live cursor K
[V Use Filed Region to Select

. Cancel
[ Use default snapping range

Shapping range [in pisels) |6 jl
= Calor
Picker

pixelz): ,2_ ﬂ - i‘

-

griligl
Speed Scroling
" Mo speed scroling

* Permnit speed scroling while moving objects

™ Abways permit speed scroling

Freview Smoothing

v Enable previews

™ On Stopped - Preview only after cursor stops maving
™ Low - Only fast ghost previews

* Medium

" High - Usually ghost previews

(™~ Ghost previews alwaps uzed
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With this feature enabled any selected object will have a colored highlight around it for easy
identification.
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Simple CAD Drawing:

This section describes basic drawing of a simple shape and how to prepare this shape to be cut. Please
refer to later sections of this manual for further explanation on topics discussed.

Creating a Shape:

The Torchmate CAD’s main screen has a tool bar along the left-hand side of the screen and an
information bar along the top. All drawing is done in the main screen defined by the rulers along the
margins. The top bar displays the size of the object, its position and scale. The left-hand tool bar
contains tools used for drawing and manipulating objects.

L] Torchmate CAD - Lintitled1 10
Fe It Layot Aeage Machine Trarslors Iwage View Opbors Help

Otseets &
[REEET%

RFGH

Eﬁﬁyk“"

Encra®op>w

»
BT 1. Tor T L T Pl 1 T [l T T L Tl T T LT [ T e T =T Tl Tl T T el o LT T T L ol T T T T el

4 [BLayer 1

" M et Dy ]

On the left-hand bar the shape tools can be accessed. The ‘Shape Tools” menu has a few simple shapes to
start most part drawings with (circle, oval, square, polygon, star, arrow and arch).

@ EOCXRD O TR |
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Begin by drawing a simple rectangle; the size is irrelevant as it can be adjusted later. To do this simply
click on the rectangle icon from the ‘Shape Tools’ menu, then click and drag to draw out the rectangle in

the work area.
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To change the rectangle’s size select it by clicking on the edge of the part, then on the top tool bar type in
the X" and ‘Y’ dimensions that are wanted and press enter.
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Draw a circle using the same method.
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Zoom in on the shape by using the ‘Zoom Tools’ pull out along the left-hand tool bar. Next move the
circle to position it inside of the rectangle.
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Once the circle is positioned in the rectangle select both objects, this can be done a few ways. Using the
‘Selection Tools” from the left-hand toolbar click and drag a blue box around the two objects this will
select both of them; another way is to go to ‘Edit” > ‘Select All’.
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With both objects selected go to ‘Arrange’ - “‘Make Path’. This option tells the CAD that all objects
selected are one part, allowing the software to determine if something is a hole or cutout.
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To verify that Torchmate CAD perceives the part as it is intended go to “View’ - ’Show Fill’ this option
displays the part as the computer sees it.
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With “Show Fill” on the part will fill in what is perceived as the part. Holes should be empty with the
metal part filled in.
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Once the part is finished it can be resized again if necessary, this resizing will adjust the hole’s size along
with the part’s size.
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If the part is the correct size and ‘Show Fill” appears correct the part is ready to have a tool path created.
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Creating Tool Paths:

To create a tool path go to ‘Machine’ - *‘Create Tool Path” > ‘Male’.
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For this simple part the only changes to be made are under the ‘Lead In/Out’ tab. Create a lead in by
specifying a length and angle. Then press ‘OK’ to create the tool path.

Male: Default Template [5__(|
Template] + Baszic Cut + Lead In/Out l
Control
[v Create Lead In [ Create Lead Out
Lead in
T ¥
f+ Line " Online -

Lengh | 01000 m j j
Angle: 30 ﬂ j

Dwerlap: 0.0000 in j

I~ Adjust start point

Lack Template | ak. | Cancel Help

22

—
| —



The screen now has two objects on it, the original part drawing and the tool path. The original drawing is
no longer needed and needs to be removed.
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To eliminate the original drawing go to ‘View’—> ‘Show Tool Paths’ and ensure that it is unchecked.
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The only object visible now is the original object.

0] Tarchwmate CAD . Lintithedd . C00
Bl E3 Lwodt frange Machre Drarsfom jeage Yew (phioes Heb

= mern Hee swo H oo Hy o O oomm 4
Jompe "™ *H

paane 3330500 3T few ] mom 3

BIGABBO A hednh RETHS

2
L5 =
A Al
H
a: »
. o
&y =
&
\;H
&
0
]
R
B
]
|z}« 5
W @le] oo ¥

120 ADE S N AR e R R A L P E RN O DN N e P IR S N R E R D N E EEE

salsmd [Bayer

Select the object and press ‘Delete’ the screen will be blank now. Go back to ‘View’ - ‘Show Tool
Paths’.
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The only remaining object is the tool path, this part is now ready to export to be cut.
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Exporting Files:
To be able to cut a part it needs to be exported as a ‘DXF’ format. To export go to ‘File’ > “‘Export’.
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Ensure that the ‘Save as type’ is listed as ‘DXF (Polyarc)’. Give the file a name and ensure that the
location of where it is being saved is known. Select ‘Export’ and the file will now be able to be imported
into the driver software to cut.
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Using Guides and Alignment Tools:

Guide Tools:

In Torchmate CAD guides can be used to align objects and nodes. To access the ‘Edit Guides’ menu
have no object selected and right-click on empty space, the menu can also be accessed by going to
‘Options’ select ‘Guides’ and “Edit Guides’.
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Guides use the coordinates related with the rulers. To add a line type in the coordinate the line will be at
and select add. Horizontal, vertical, and diagonal lines can be added.
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Once guides are created an object can be ‘snapped’ to the lines.
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To snap an object to the guides move the object over to the guides, when the edge of an object turns
purple the object is aligned to the guide.
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Obijects can be snapped to any edge as well as to the center line of the object.
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A diagonal line can be added two different ways, either by specifying a single point to pass through and
an angle or by specifying two points that the line should pass through.
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Any line can be added parallel to an existing line by selecting the ‘Add parallel line at normal offset’
check box. A new box will appear to enter how much of an offset should be used.
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With diagonal lines an object can also be snapped to a corner, it will turn purple similar to an edge or the
center.
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Guide lines work for nodes as well as objects.
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Nodes will snap to the guide lines when they are moved near them, this allows for multiple lines to be
aligned to each other.
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Another way of aligning objects is to go to ‘Options’ select ‘Grid” and then ‘Snap to grid” with this
option enabled the object’s edge will attempt to align with the nearest grid line.
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Alignment Tools:

If two objects are created that need to be aligned another method is the alignment tools. Go to ‘Layout’
select ‘Arrange and Distribute’ and then ‘Alignment’ the top tool bar will change to the alignment
options. ‘Alignment’ opens the full options the other choices in the ‘Arrange and Distribute’ are quick
links to the alignment options.

A I oT# L = ] ! Vertical Alignment Options
O'a
T e == I
: I = Horzontal Alignment Options
Alignment Eeference
Alignment Options
Mo Alignment

Zpacing (uzed only when aligning to sign blanlk)
The alignment reference area specifies what the objects are being aligned to.
Align to Sign Blank — Aligns the selected objects to the material guide.
Align to Grid — Adjusts the position so that the objects selected align to the nearest grid line.
Align to Last Object — Aligns to the last object created of those selected.
Align to Selected — Aligns the objects based on what objects are selected.
For both the vertical and horizontal alignment there are four options.
None — Does not change the alignment along this axis.
Top/Left, Bottom/Right — Aligns the edges of the object to the direction(s) specified.
Center — Aligns the objects centered to the reference area.

Spacing is used when aligning to the sign blank. This will space the objects equally across the material
size. The values that are entered in the boxes adjust how far from the edge of the material the objects will
be.
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The last method of aligning objects is to use the ‘nub’ tabs on the top tool bar to reference coordinates.
When an object is selected it will show nine black nubs next to the coordinate and measurement boxes.
The nub that is red is selected; the coordinates displayed will correspond with the nub on the object.

File Edit Layout Arrange Machine Transform Image View Options Help

2w 149132 <] 1000000 ﬂz% ¢ oo e I

5% 1amaz 2 onoo <

‘ This mub corresponds to this pomt and these coordinates.

ERhERGOOP >7|y

Using the alignment nubs two points on two objects can be aligned to the same coordinates simply by
changing the coordinates in the boxes.
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Using Array and Badges Features:

For applications that require creating multiple copies of the same part Torchmate CAD has two main
tools, ‘Array’ and ‘Badges’, both are accessed through the layout menu.
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Array begins creating duplicates based on where the part currently is.
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The array toolbar uses a pull down menu to select which type of array the CAD will create.
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Grid, vertical, staggered, or horizontal all work on the same principle. The tool options allow for spacing
along each axis as well as how many copies are desired.
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‘On Arc’ arrays specify how many copies and a distance from the center, the parts are then arranged
equally around the original part equally spaced.
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‘On Arc with Rotation’ creates the duplicates around the original equally spaced as the ‘On Arc’ does, but
it will also ensure that the part’s base is facing toward the center.
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Badges is similar to array but designed specifically to fill a sheet.
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The ‘Badge Setup’ window allows the parameters to be set. On the upper right of the window the number
of copies that can fit on the sheet with the current settings.

Badge Setup rg|
Mumber of copies 238 = Max copies per page: 325
™ Use Score Lines ™ Uze Plate Replaceable items / test

Colar; m - [highlight text to be changed)
M aterial

[~ Custom Size

Height |£0.00 Width |1200
Margins

Top |0.150 Bottorn |0.150
Left |0.150 Right |0.150

Spacing

Vertical |0.250 Huorizontal {0,250

™ Group each badge

Page preview )
™ Feplacement data file
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Total Mumber of Pages |1
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Editing Text:

Torchmate CAD allows various methods of editing text that can be used in conjunction with other tools to
create fabulous results.

To start editing text select the text tool from the left toolbar. Select where the text needs to go and click,
then type in the desired text.
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Once satisfied with the text in order to edit the text further it must be converted to a graphic. With the
text selected go to “Arrange’ = “Text to Graphics’. The letters are now individually selectable and can
be manipulated as any other drawing. Examples below illustrate some basics of what can be done.
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Cutting Text Out of an Existing Shape:

Once the text is created and converted to a graphic position it on the object being cut out of.
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Once positioned go to ‘Arrange’ = ‘Make Path’. What this function does is tell the CAD any
overlapping part is a cut out of the main part.
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Once a part is done it is always a good idea to go to “View’ - “‘Show Fill’. Show fill displays the part as
the computer sees it, white space indicating scrap areas. When working with text letters with cutouts like
‘0’, ‘B’, ‘A, etc. the cutout will fall out if it is not bridged.
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To bridge a letter simply draw a small rectangle over the area wanted to be bridged and complete a ‘Basic
Weld’ from the weld menu on the left hand toolbar.
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Welding Text to Objects:

Text can be attached to simple or complex objects. Once the text is converted to graphics be sure that the
object slightly overlaps the text. Select all objects and text being joined and go to the weld tools menu. A
‘Basic Weld’ will merge all overlapping objects and text together.
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Be sure to turn on show fill once all editing is done to ensure that the CAD software is interpreting the
drawing as it should be cut.
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Resizing Text:

Text made in Torchmate CAD can be resized after it is converted to graphics. Simply select the letters
needing to be resized. The letters can be resized like any other object, (using the corner tabs when
selected or adjusting the scale from the top menu).
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Once the letters are resized they can be manipulated any way normal letters can.
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Joining Script Text:

Node editing can be used to join script style text together to make a single cut for an entire word.
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To start convert the text to graphics, then move each letter close together so that they can be joined.
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Double clicking on a letter will open node editing. With node editing the letter can be manipulated to
any shape that is needed.

L] Torchmate CAD [Made Edit] Lineitied T4
Fia D8 Layot maege Machre Tiwsiom lnage Vew Cpeoes beb
o o pm 4 §
12164007 2 =} 'm_:' E e 454 e
h. p‘ﬂ é«r ‘ e gline
RO AS

RTLABE o oW B wE R0
¥ ) 1 ¥

ELnc¢r a@fop>w

£

EEL KT PTET) — i P —— S 8] oo
ERICE PR o[ ] ee] e Bl Lt Lall s draal Pl ool A Ll ol el sl s fal s Ll el fal s Le] el e el ] ]
Mo sned (B ayer 1

Unselected nodes are blue in color while a selected node will be red. To select a node click on it, or drag
a selection box around a group of nodes. With a node or nodes selected they can be moved around.
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To join a script text together the goal is to overlap all letters and then weld the individual letters together.
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Be sure to overlap all script areas, so that welding can be done later.
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Once all letters overlap the text is ready for welding.
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Start by selecting all the letters, and then choose a basic weld.
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The letters are

now all once piece and ready to be cut out. One thing to keep in mind is the thickness of

the bridges, if they are too thin when cut out they may bend or break.

L Tor

rebmate CAD - Lintitled .CI0

Fa I8 Layot Arvange Machre Trasfom Image Vew COpoioes Heb
[ o srrmom Heom  {wmm Hxo Gom 4
rmasia v Hiow Ham H@ .

FRAB oo BN
T o T 0 3 0 =

=

I ] 3 5 ¥ ¥ e e e ]

ERcEafpr>wly

L

€ ¥
ji| om

PRI . . T[T~ [Tl T Al ] T TPt T el T LTt TG Tl T Tl o T oL T T Tl T [ [T ]
ajani] By




Fitting Text to an Arc:

Text can be aligned to an arc to create arches or to follow a specific curve. These features are
automatically done with the optional ‘Pro Text” module. The instructions below show how to do this

function without the additional module.

The first step is to draw a circle or oval that the text needs to be fit around. Once the text is converted to

graphics each letter can be moved. Start by positioning the letters around the arc.
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The next step is to rotate each letter. When a letter is selected there are nine boxes around the part as well

as a small rotate tab, click on that and as the mouse is moved the letter will rotate.
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Once all the letters are rotated, delete the arc if it is not needed. This process can be done with shapes as
well as arcs, or any shape desired.
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Text Techniques:

The techniques can be combined to create various effects.
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Here is a combination of manipulating text along a path and cutting out text.
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Combining text editing with other skills in Torchmate CAD can allow for creative use of text and plasma
cutting.
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Working with scan tools:

The first step in using a scanned image is to ensure that it is the proper format. To do this open the image
in any picture editing program such as Paint.
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With the image opened save the file as a monochrome bitmap. This is the file type that Torchmate CAD
will recognize for scan tools.
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With the file as a monochrome bitmap go to Torchmate CAD, File > Import and select the file.
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Accuscan:

With the image brought in scan tools can now be used. For most applications using “accuscan” will be
the best option. What accuscan does is look at an image and it will interpret any black shapes as parts that
will be kept as metal and any white parts of the drawing as scrap. Using a “centerline” scan will have the
software look the drawing and try to interpret lines, if there was a thin square or box the software may
interpret this as a single line not the shape that was wanted.
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Once accuscan is selected the tool bar on the top will ¢
used are two buttons called “trace setup” and “vectoriz
that the computer takes into account when interpreting
numbers and runs a scan on the image creating a line d
settings. By varying the settings in the trace setup and

hange to the scan tools features. The main features
ation”. Trace setup specifies various tolerances
the image. Vectorization takes the trace setup
rawing as the computer sees it with the current
running multiple scans each one can be compared

side by side to find the best line drawing for a particular image.
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The trace setup for accuscan has a few key settings. The main two are the line fit tolerance and corners.
These two features adjust how accurately the computer is trying to follow the image. The additional
options effect issues relating to the scanning of an image from a flatbed scanner. If there is significant
dust on the image the speckle filter can attempt to clean it up, the snap lines feature adjusts lines if the
drawing was crooked in the scanner, and small shape accuracy can compensate for low resolution scans.
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Once the trace setup is done clicking on the vectorization button creates the line trace. There are now two
objects on top of one another. Moving one off to the side the two can be compared.
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Repeating vectorization multiple times with different trace setups allows the comparison of settings in
order to determine the best one for a particular image. Each image brought in may have different trace
setups based on the quality of drawing and scan.
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Zooming in reveals small subtleties of the two scans, the left scan is done with 10 and 10 as the line fit
tolerances while the right image used 1 and 1.
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Once the ideal trace has been done the next step is to clean up any necessary defects. The first part of the
process is to ungroup the trace so that each piece can be edited individually.
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To edit a particular part double click on the line and Torchmate CAD will enter a node editing. Generally
when an image is traced there will be an excessive amount of nodes, there a few ways to eliminate them.
The most straight forward way is to select the unneeded nodes and press delete, this can work well but if
there are hundreds of nodes this can be time consuming. Another method to select nodes to delete is
while in node editing select all of the nodes (F3, Ctrl-A, ‘Edit” - ’Select All’, or clicking with the arrow
tool and dragging a selection box around all nodes will select all of the nodes). Once all nodes are
selected press the ‘U’ key; what the ‘U’ does is take all of the nodes selected and select every other one.
With every other node selected press delete, this process cleans up a significant amount of nodes in one
sweep. Repeating this step a few times can reduce the number of nodes to a manageable amount.
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Once the outside is done the letters need attention too. These can be done in the same way selecting
nodes and deleting them.
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Once the letter is to a point where the only nodes left define the corners the letter may not look correct,
almost ballooned sometimes. To correct this issue the nodes need to be changed. There are three types of
nodes, a circle node is a rounded node, a cross is a sharp node, and a triangle is a tangent node. With a
node selected, right click and move the mouse over the selection wanted and release.
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Once the nodes are squared reposition the nodes by selecting one and moving it.

the correct position press the apply button.

Once all the nodes are in
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After all node editing is done the drawing is ready to be finalized.

] Torchmate CAD - Lintitled! . CI0
Fia D Layot maege Machre Tiwsiom luage Vew Cpeoes beb

B G fiE i fec H

- =
BTRES oS R LA
‘E_' T 0 7 3 T3 W W T W - = W 2 W w £ T £ 3 o3 AJ
A
aﬂ
LY
;_.lt
%
e
EA
. N
7N
N )
" //\} %%
( SOV />
; O 4
s - (e e
= 7 T N )
- \ 22N\ )
\\ \ v \ \\\\
N AN
£ L \_F
i\ ’v
Bl M

EREPERT T SE L R L LD PR R T L ER PR e el (o] Rl L e L S R L T

walaiwd [ Myes

60

—
| —



Select ‘show fill” from the ‘view’ menu, the CAD software is now displaying the object as it sees it. In
this case the object is not correct as the letters are not visable.
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To remedy the problem select all and go to arrange and make path this tells the computer all that is
selected is to be seen as one object.
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Now with show fill on the object appears as it should and is ready for tool paths or further manipulation.
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Center Line:

Center Line scanning is used when the scanned image is not shaded in but rather a line drawing.
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The “Tracing Setup’ for center line scanning is similar to accuscan’s. Tolerance will adjust how tightly
the image is followed; corner sensitivity will affect how close corners are cut.
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As before multiple scans can be done slightly changing the settings. This method allows for side by side
comparison of trace settings to find the ideal one for the particular scan.
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When a trace is done with center line scanning the resulting image will be grouped together. The first
step in editing the image is to go to ‘Layout’ = “‘Ungroup’.
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Depending on the quality of the trace the image may be in multiple parts, Torchmate CAD indicates how
many objects selected in the upper left corner of the toolbars.
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Some of the objects may just be double lines or scribbles, by moving parts away temporarily objects
underneath can be seen.
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Any fragments or double traces can be deleted until there is just the desired objects left.
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The traced object is now like any other object in Torchmate CAD it can be manipulated, added to, scaled,
or tool pathed. To join the two objects as one go to “‘Arrange’ ->’Make Path’.
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Just like any object “‘Show Fill” from the “View’ menu displays how Torchmate Cad perceives the
drawing.
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Node editing can be used to clean the object up. In this case selecting nodes that are unnecessary for the
overall shape of the object.
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The outside part is now cleaned up, the inside hole can also be cleaned up in node editing.
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If a hole comes out jagged from the trace node ending can be time consuming.

option is to redraw the hole with the circle tool.
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Begin by going to ‘Arrange’ - ‘Break Path’ this separates the hole from the outside part.
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Draw a circle

the desired size.
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Position the ¢

ircle where it needs to be and delete the original hole.
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Just as before the objects can be made into one part by going to ‘Arrange’ > ‘Make Path’.
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This object can now be duplicated, nested, scaled, or whatever needs to be done before being cut.
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Nesting:

Torchmate CAD allows for multiple parts to automatically be rearranged maximizing the use of material
space. This feature is called nesting and can be used on any part drawn in Torchmate CAD.
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The nesting feature uses a defined material size as its guide to arranging parts.
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In the ‘Material Size’ window found in the ‘Layout’ menu the size and orientation of the work area can be
defined.
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Before nesting can be done all of the objects must be selected, Torchmate CAD will only nest selected
objects. Go to “‘Edit’ and select ‘Select All’, CTRL-A and F3 can be used as shortcuts.
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To access the nesting options go to ‘Arrange’ and select ‘Nesting’.
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Once nesting is selected the top toolbar will change to the nesting options.
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Nesting Options:
Starting Corner — Choose a corner that the nesting will originate from.
Nesting Direction — The direction that the nesting will proceed based on the starting corner.

Rotation — Specifies how much each part will be rotated, this is a step rotation so if 60 degrees is
specified each part will be turned in 60 degree increments resulting in six possible orientations. The
smaller the number is (excluding zero) the more processes the computer will take calculating the nesting.

Nesting Border — This specifies the distance between parts and the edge of the material sheet.
Clearance Between Parts — The minimum distance maintained between parts once arranged.

Error Factor of Clearance — During the nesting process, approximations are made that are based on the
magnitude of shapes being nested. Setting a small Error Factor will produce more consistent spacing
between shapes but increase the processing time. A larger Error Factor will create less consistent spacing
but decrease the processing time of the nesting.

Allow Mirrored Parts — This allows objects to be flipped around to better nest them.

Keep Groups Intact — If this option is off grouped objects will be separated when nested.
Include Toolpaths — Accounts for the diameter of the toolpath in the nesting calculations.

Block Nesting — When selected treats each object as a simple box.

Nest Parts in Part’s Holes — This option allows small parts to be moved into larger cutout areas.
Select a Sheet — Allows a specific sheet to be used to put the nesting results on.

Apply — Takes the current settings and begins the nesting process.

Close — Cancels the nesting and returns to the main CAD window, no parts will be nested.
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Once apply is selected the nesting process will begin. The process can take several minutes to complete
depending on the settings. Nesting can be done as many times as necessary with changes in settings or
additional parts added in.
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Advanced shape creation:

Torchmate CAD allows for the creation of unique and creative parts. Certain parts require going beyond
the basic skills and using all or most of Torchmate CAD’s features.

The “Shape Tools’ allow for simple shapes to be made, the simple shapes can be manipulated in order to
create more advanced parts.

@dEORXD O

Any shape created with the shape tools will have two different tool bars along the top of the CAD
window that can be brought up. The standard shape tool bar is present for any shape or imported drawing
when first selected. This tool bar allows the position, scale, and rotation to be changed. The shape
specific tool bar is accessed by double clicking on a selected shape. The shape tool bar is only accessible
for shapes created from the “‘Shape Tools’ menu, double clicking for all other shapes will enter the node
editing mode.
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Starting with a simple rectangle or square go to ‘Transform’ and then choose ‘Round Corners’.
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When ‘Round Corners’ is enabled the top menu will have a dialogue box that allows the radius to be
specified.
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The rectangle tool also has sliding tabs that can create rounded corners. Select either of the tabs and slide
to change the radius, there is also an entry box on the top tool bar that allows a specific radius to be set.
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‘Round Corner’ rounds all four corners of a square. In order to round one corner at a time, or to round
corners on non-square shapes use the ‘Fillet Round Corner’.
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A similar toolbar will appear on the top. In order to specify which corner or angle to be rounded click on
the corner, when done click apply then close. The ‘Fillet Round Corner’ tool can be used multiple times
to make various radii sizes on different corners.
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The next tool is the ‘Polygon’ tool. This tool allows the creation of polygons ranging from three to thirty
sides. When editing the polygon there are a few fields that can be specified to allow for more advanced
shapes, specifically the radius of each tip and the radius of each edge.
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The “Star’ tool has similar settings to the ‘Polygon’ tool with a few more added in. A star can be made
with three to two hundred points; each point can have a radius point as well as a radius inside.
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Torchmate CAD can also create arrows and arches. These shapes have just as many features as the other
shapes.
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File Edit Layout Arrange Machine Transform Image VYiew Options Help
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The weld tools included with Torchmate CAD allow the combination of shapes to create cutouts or tabs
along with other shapes. To use a welding tool select both objects desired to be welded and then select the
appropriate weld. One thing to keep in mind while using the welding tools is that all three operate best
when only two objects are selected; weld tools also only work if the two objects overlap each other, even
just slightly.
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Node Editing:

Nodes can be used to create shapes as well. Nodes are defined points that are connected by lines. In Torchmate
CAD each node is generally blue and when selected the node turns red. When a node is selected on the top bar there
will be two coordinates that can be changed to move the node to the desired point. When a node is deleted the nodes
on either side will join together.

%\ &

With the node edit tool selected simply click on the work area where the node is to be placed. As each subsequent
node is placed the line will extend along the path. To exit out of node editing select the apply button, or if a closed
shape is desired double click on the starting point to connect the path fully.
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There are many distinctions to be made between nodes. On every shape there will be a single node that has a small
arrow originating from it. This node is the ‘Start Point’ this node is the first in the sequence and the direction of the
arrow. If the drawing is not closed there will be two un-joined nodes, these nodes can be joined to other shapes, or
joined to each other. There are three types of nodes as well, ‘Rounded’, “Tangent’, and ‘Sharp’. A rounded node
defines a curve; this node references its two adjacent nodes for curve information editing any of these nodes will
change the dynamics of the curve. A sharp node is used to create the straight lines and angle changes between lines,
sharp nodes are the simplest nodes as they basically pin the curve to a point. A tangent node is used to transition
between rounded nodes to sharp nodes smoothly.

Eounded Modes

e \
Un-Joined Modes /\
\\#‘:—"’“‘S Poi
tart Foint Tatgent Mode

\

Sharp Modes

When a node is selected additional features can be accessed by right clicking and holding. Depending on the image
type there will be up to eight options. Move the mouse over the option desired and release the right mouse button,
this will select the option highlighted.

Join
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*He
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Dielete Selected Mode Tn-Toin
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Node editing can be used to join two unrelated objects together. To get into node editing for a shape double click on
it. Initially the two objects can be edited but not at the same time.
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To tell the computer to think of both objects as a single part so that all nodes can be edited at once select both
objects and go to ‘Arrange’ and select ‘Make Path’.
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With the paths joined the next step is to edit the nodes to create a bridge between the parts.
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Once the nodes have been broken they can be moved closer to each other. To join the nodes to other broken nodes
select both nodes, to do this either draw a selection box around both or hold down the *shift” key as each node is
selected. Once both are selected right click and choose ‘Join’. Once both sides of the bridge are joined there is a line
left over, this can be thought of as scrap. This scrap piece can be removed a few ways, if it is a fairly simple shape
the easiest way is to simply delete the nodes.
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If the shape is more complex the way to delete the scrap is to break the path. Select the part and go to ‘Arrange’ and
‘Break Path’. This separates any un-joined parts into distinct objects.
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With the objects separated the scrap can be selected and then deleted.

] Torchmate CAD - Lintitled! . CI0

Fe £ Lot Gmange Mache Trslum Image Wew (phoes Hep

5 81 see @ Heedm  Homm & om A
BER i f7o fon fe N
+hIOA<
RTLABEO o W AN
. R = 5 W = = = £l 1= = e = = = L
AL ErEE e
a // ., g
L =z N\
& -
il" 7t \
- -
: { \
Al i \
'\"‘\"‘-‘\._ ~ \
e
" b -
: "\_MH“‘*HK N h"“-——-_____
M == ™ Tttt
L < “““‘-u,.____ \\._ s o @ /'/
T ; o/, = _d
i \x 15 'x\\ o o e | il
Ty .
] N AT 4
: /')J it T T
C yii T =y
. | /
N //
.
N ol
o T— — .
. L ¥
Fee e vericaly @] 0w s

120 AR AR e R R A N P E RN O DN N e P IR S N R E R R D N E

Nodes can also be used to edit existing shapes, even shapes that are created with shape tools. For any shape created
with the shape tools there is one step that must be done to be able to node edit. With the part selected go to
‘Arrange’ and ‘Convert To’ select either ‘Polygon’ or ‘Polyarc’. Double clicking on the object will now bring up
node editing. The process of converting will not allow the part to be edited further by the shape specific tool bar.
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Once converted nodes can now be edited.
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If the object is converted to curves or polyarc the edges can be changed into curves by hovering the mouse over the
edge, it will appear as a hand. Clicking and dragging will adjust the curve.
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Understanding Paths:

In Torchmate CAD a path can mean a few things mostly it refers to either a tool path or an object. When
a path refers to an object the path is essentially the whole part. For simple shapes the path is just one
object. Once a part contains holes or cut outs then the path contains multiple shapes. In the Torchmate
CAD the path of an object can be broken, connected, or made all path options are accessed from the
‘Arrange’ menu.

Make path takes multiple objects and tells the CAD to consider them as a single part. Make path is used
primarily to create holes in objects. Start with an outline and a few holes.
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The part when it is just created is four separate objects the objects need to be merged together to one part.
Select all objects that compose the part, then go to ‘Arrange’ and select ‘Make Path’.
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The objects are now one part and one path. The best way to ensure that this is the case is to go to ‘View’
and select *Show Fill’ this displays the object as the CAD interprets it; the filled in parts indicating the
actual part.
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The object is now a single part that can be moved around, all of the nodes can be edited at once as well.
To edit a single hole or the outline without changing any parts use break path the separate the objects
back to individual elements. Any element can now be changed. Once changed select all parts and ‘“Make
Path’ again to revert the objects to a single part.
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Using ‘make’ and ‘break’ path allows for the editing of single components of a part or the merging of
elements to create a part. Show fill is an invaluable tool for keeping track as to what stage a part is in as it
will show what the computer is considering a part.

‘Connect Path’ is used to join gaps in a object, these gaps can be very small and will generally occur in
objects scanned or imported in to Torchmate CAD. The easiest indication that an object needs to have
connect path applied to it is when “‘Show Fill’ is on; any object containing a gap will show up as a dotted
line.
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Select the object and choose ‘Connect Path’ from the ‘Arrange’ menu. The CAD will ask for an
‘Allowable Error’ this is the maximum distance it will attempt to join a gap.
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Importing DXF Format Drawings:

The DXF format is a universal exchange format for dimensioned drawings. Torchmate CAD can import
DXF files and once in the CAD they can be manipulated and toolpaths can be created.

To bring in a DXF drawing the first step is to create one in another program, in this case AutoCAD.
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Depending on the program the option to create a DXF may be listed under ‘Save As’ or ‘Export’.
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The program being used may have multiple options for which type of DXF to export as some will yield
better results than others when brought in to Torchmate CAD.
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Now that the DXF is saved go into Torchmate CAD, go to ‘File’ and select ‘Import’.
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Once the drawing is placed the first step is to ensure that the part has been imported correctly. Go to the

‘View’ and select ‘Show Fill’.
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Show fill displays the object as the computer sees it.

a toolpath created.

If the object is filled in solid then it is ready to have
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There are a few methods to try to correct this issue. The first method is to select the object go to ‘Arrange’
and select ‘Connect Path’. The CAD will join any gaps within the prescribed gap tolerance.
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If connect path did not correct the gap the second method is to go into node editing. Double click on the
object to enter node editing mode.

L2 Torchmate CAD [Mode Edit] Drawing] .C0L
Fie B Loyt Arangs Machion Tramform Jnage Vew Oplios Heo

21334250 I e 4 '_“g =i e |
Ll bl Af- A e
LS N L L ISERER |
g oae
|/ i 82 B
N . T . W N El N El N £ . 7 N £l N = T = L3 N i N = N w ".Iﬁj
A F|
Al® |
Ef

@ ]
® =)
i
@|v: =
< e
£ 7 yd
<L e

¥ /

Jfr -
H /
p
1//
5 /
P
A
i

"

td

|%)« » gy

Het K ARG AIRTOI % A |

M40 EEEEEEN - EEEEEEEEER NS EEE PR EEENEIEPEEEEN D OEEEEEE R EEE
ERIC - T




Select any node and it will turn red. If the “Tab’ key is held down the CAD will cycle through the nodes
selecting each one in sequence. If there is a gap the cycle will stop and pressing ‘Tab’ will do nothing.
At any place there is a gap select the node, hold down right-click, this brings up the node options. The
top middle option is join this will join the node with a nearby un-joined node. Verify with ‘Show Fill’
that the part corrected.
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Another issue that can arise when importing a DXF occurs when the drawing has inside and outside parts.

In this case the fill displays each object as solid, the CAD simply does not associate the hole with the rest

of the part.
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To correct this first select all of the components of a single part.
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Go to ‘Arrange’ and choose ‘Connect Path’ this will tell the CAD to think of every object selected as one
single part.
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Once the part is corrected ‘Show Fill” will display it correctly.
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When importing DXF files keep in mind that some parts may have no issues while others can have
several, it is always a good idea that before proceeding to cut or edit the part ensure that it is correctly

imported.
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Frequently asked questions about tool paths.

What is the difference between a Male, Female, and Online tool path?

Tool paths come in three varieties male, female, and online. The difference has to do with how the tool
paths are offset from the original drawing. When cutting with plasma there is a certain amount of
material eaten away this is called the kerf. In order to maintain the dimensions of a drawing the tool path
needs to be offset from the drawing. An outside cut will use a male tool path and an inside cut will use a
female tool path. An online tool path does not offset for any kerf and simply created a tool path along the
center line of the drawing. Lead ins and lead outs are also created based on these offsets.

Plasma Path

: /
Original
Drawing

Male Female Online

I have a part with a hole cut in it, what type of tool path do I use?

When a tool path is made in Torchmate CAD the type of tool path selected will determine how the
outside cut is made, any inside cuts will be made opposite of the specified type. For instance if a plate
with a hole in it has a tool path created select a male tool path, this will make the inside holes female
automatically, all the critical dimensions will then be maintained.

Lead ins? Lead outs? Do | need both, some, or none?

For plasma cutting it is generally a good idea to create a lead in. What a lead in does is move the pierce
point of a cut away from the finished edge and into an area of scrap. This prevents a dimple from being
created on the part where the pierce occurred. In Torchmate CAD when a male or female tool path is
made the lead in will be created to coincide with the offset direction. With plasma lead outs are
generally not used especially if a height control is being used. If a lead out were used the part would
finish cutting and then go to the lead out, the scrap piece may shift or fall out the arc will attempt to go
somewhere this will result in the torch either diving down to follow the falling slug or the arc jumping to
the part edge causing a divot. Oxy fuel torches can use a lead out to do common line cutting or in general
to ensure a full sever.
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Arc or line lead ins which are better? What is the difference?

In most cases the difference between an arc lead in and a line lead in comes down to personal preference.
The area where one would be preferred to another is when cutting inside holes.

Pierce Point Pierce Point

Line Lead In Arc Lead In

Cut Direction Cut Direction

Transition Area Transition Area

For a well calibrated table with minimal backlash a line lead in should be used, this will result in a cleaner
transition area. The issue with an arc lead in occurs when the plasma’s path comes around to finish the
cut; it will encounter an area that has been partially cut on, and this can result in a divot or excess slag
forming in the transition area. In outside cuts or non-circle inside cuts the lead in type generally will
make no difference to the final quality.

Can | adjust my lead in points after | have created a tool path?

In Torchmate CAD the lead in length can be adjusted, this is similar to node editing a regular object.
After a tool path is created double click on the tool path. The tool path will have blue points along it that
indicate direction changes. The lead in will have a node at its end that can be selected and moved to a
desired position.

T /A
>

\ \

The point where the lead in connects to the part can also be adjusted after the tool path is made. When
the tool path is selected and in node editing mode (by double clicking on the tool path) the top tool bar
will have twelve small boxes, one of them adjusts the start point. Simply select the start point tool and
click on the part where the new start point should be.

s

I

Edit Start Point
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When | create a tool path what do all of the options do in the menu.

When creating a tool path there are three tabs that are accessible. The first tab is called ‘Template’ this

tab can be used but will not affect the tool paths if it is never used.

Male: Default Template El Male: Default Template El
Template |  Basic Cut | v Lead In/Out| Template  Basic Cut | Lead In/Out |
Contral Toal
I aterial i~ |Plasma j

|Delau|t Material, Jin

Drefault Material, 1/2in
Default Material, 1/4in

Default Material, 3in

Template

Narne: Detault Template

Direction

W Filter by Material Conventional ¢ a Climbing ﬁ

Color Tool Path Comering

_— — e
Delete Move Contral
D ] B e A,

Feed rate: U-UUUUJ irmin Power Dj 4

[V &uto Make Path Assist o.uuuoﬂ Dwell time: o.uuuﬂ 8

Lock Template | | | oK | Cancel | Help ‘ Lock Template | ‘ | oK Cancsl | Help |

If this tab is used what it stores is the information from the other two tabs as a material. For instance the
settings can be set for one thickness, once the settings are made selecting change on the bottom row of
buttons updates the selected material so that in the future the settings load with the specific material.
Again if nothing is ever changed on this page the tool paths will never be affected.

The second tab is called “‘Basic Cut’ this tab controls the tool being used as well as the shape of the cut.
The tool pull down menu allows any tool from the tool library to be selected. The tool is what defines the
offset to be used. ‘Direction’ specifies the motion of the tool around the tool path. ‘Conventional’ will
create cuts so that an outside cut travels counter-clockwise and inside cuts will be clockwise, ‘Climbing’
will create the opposite direction tool paths. For plasma cutting a ‘Climbing’ cut should be used, for
routing generally a “‘Conventional’ cut would be used but this can vary based on the bit used. The ‘Tool
Path Cornering’ option allows for sharp or rounded corners to be created, in almost all instances a sharp
corner is desirable. ‘Move Control’ is used if the g-code is being output from the Torchmate CAD in
most cases this will be unused.

The third tab is ‘Lead In/Out’ and controls all aspects of lead ins and outs. The check boxes at the top
enable a lead in, a lead out or both. For either type there is a choice between *Arc’ or ‘Line’. When an
‘Arc’ is selected a radius can be specified this is the length of the lead away from the actual cut. For a
line both a length and an angle need to be specified, this angle is in reference to the start point so a 90
degree angle will be perpendicular to the cut path. For lead ins an ‘Online’ lead can also be selected this
is a lead in that will pierce on the part just a certain distance back from the start point; as the pierce is on
the actual cut this type is generally not used. ‘Overlap’ is used to continue cutting past the start point
before finishing a cut, this is used sometimes in oxy fuel cuts or with some plasma cutters that have a
tendency to not finish a cut completely. Finally on this tab is ‘Adjust Start Point’ this allows for rough
relocation of leads to the corner specified.
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How do | reorder tool path cut order?

In Torchmate CAD there are multiple ways to reorder tool path cut order; each way is suited to certain
circumstances. The cut order is generally edited after tool paths have been made, some of the methods
however do allow for order to be specified prior to a tool path being created.

The simplest method of editing order is to use the ‘“Tool Path Viewer’. This method is simple to use but
when doing a large amount of parts can become time consuming. To access this method go to “‘View’ >
‘Show Tool Path Viewer’.
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The “Tool Path Viewer’ opens a window, if ‘Show Order’ is checked it will display the cut order.
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The cut order is displayed as numbers next to each part. When a part with multiple inside cuts is
displayed it is still only displayed as a single number.
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To change the order double click on any part, the ‘To Position” window will appear. The number
indicates the sequence position, simply type in the new position to change the order.

Tio Position
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Another method to reorder cuts is called ‘Sequence’. There are four sequence options, three of which are
quite useful in many cases; sequence by traits is only useful if each part is a different layer or color. To

access the sequence options go to ‘Layout’ = ‘Sequence’ here the four choices are available.
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‘Start Sequence’ is the first choice in the menu. Begin by selecting the first object to be cut then select
‘Start Sequence’.

L0 Trchmate CAD - Uintithed .C0X
Fie oot DU smwrce Machre Trsiom luage Vew Cpeoes beb

L Ml sy Jmm . (00m g

Pl meweeen o700 400 Fa St TH
L LT ] G L0 @ KK m oA
ka:‘n’_ T T L T TV ST T I ST S S T T T T, VR W B W, LT ,I’-‘J
Als Bk L. |
A Coctritin Binder it e by Vi j
als ot S by Lot »
r “hirt S by Trat 2
a3 Tanglabis B
- apateats . L
Wl I et Vet
r ip et Categpres Setip
&irl | conmeniie cutrg f

e 20

H Patarial ok Ohieit

L

x

]

| 3« »

Fee e burcrinhy @ie] o0 v

PRSP ool 1 el T [ Tl el ] b oL Tl Tt Ll Tl T Tt o Tl ol T e T ot
Mo amed (O kayer 3




A blue line will emanate from the selected part. To make the cut out order click on each part in the order
they need to be cut in.
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Continue doing so clicking on each part. For a large amount of parts this method can be a bit time
consuming however for a few larger parts it is very quick and easy.
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‘Start Sequence by Vector’ is similar to ‘Start Sequence’ but is more useful when rows of parts are used.
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With “Start Sequence by Vector’ it is not necessary to click on each part to order them, simply by clicking
on two parts will also order the parts in-between in series. This is useful for rowed parts since only the
parts on the end of the rows need to be clicked to sequence the entire sheet.
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‘Start Sequence by List’ is another way to change cut order.
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By list uses a moveable list to order cuts.
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When a part is selected from the list it will also be highlighted with a red square on the work area.
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The order is changed by dragging a part up or down the list, or by using the positioning buttons in the
menu.
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Any time the cut order is changed it can be viewed again by going to the ‘Tool Path Viewer’ in the
‘View’ menu. Keep in mind that the order displays a part with multiple cuts simply as a single number.

= x]

Enc¢h a@or>w

»
@i4] oo

e & [ '
CEEDEER T EEEEEEEEEE SRRSO REDFEOEEE P OOEEE DR PRI E R EEE
Cllayer 1

What is common line cutting and how is it accomplished in Torchmate CAD?

Common line cutting is a method of drawing that links some or all of the tool paths together as one single
path. This is useful when working with thick plate using oxy fuel or when cutting with plasma and using
an edge start method. In both these cases restarting a cut in the middle of the plate can take an upwards of
30 or more seconds or may be impossible. Common line cutting allows the tool to cut from one part to
the next without turning off. Keep in mind that the path may cross over itself while doing this, with
plasma this may cause the torch to go out and need to be restarted. Common line cutting uses a lead in
and lead out for each part, with the lead out of one part connected to the lead in of the next. The most
difficult part of common line cutting is positioning each part so that the travel distance between parts is
minimized as cutting thick plate is generally at very slow speeds.
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To common line cut begin by drawing the parts and laying them out on a sheet. Create a tool path with
lead ins and lead outs, for the sake of clarity make them with different lengths or angles so they can be
distinguished.
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Edit each tool path so that the lead ins and outs are near eachother.
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Select all of the tool paths, go to *‘Arrange’ - ‘Make Path’. This converts the tool path back to a polygon
but allows the parts to be joined together.
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Double click on the parts to enter node editing. Join the lead in of one part to the lead out of another by
selecting the two nodes, right-click, and select *Join” (middle-top option).
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Repeat this with all of the parts leaving one lead in and one lead out not joined.
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The nodes can be edited just as any drawing and the leads can be cleaned up by eliminating some of the
nodes.
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By joining the nodes occasionally the cut direction will change, to reverse it select the node that should be

the starting point, right-click, and select “Set Start Point’ (the right-middle option).
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The parts are now joined; the last step is to create a tool path again. This time the tool path will be
‘Online’ since the offset was already done the first time the tool paths were created.

L] Torchmate CAD . Untitied! CT8

£t Lajut Gerace [ULSRRY Tt lnage Vew Cpsoes Heb
g

P’ 21 s E 4 o 4
aekian et J| :::: _}:ﬂ om 4 .
Patorial Lbrary.
sl ? BRIl LS p— o !L._..._.l.‘.h.ﬁ'”‘_?’_&.. L IETE 55 3 - S . i o—
[N oo i e = : : 7 3.
= BT — T «
i o Toare e i
poor i
Q" )
® Coeremet 3 Gt T Parthy |
I Prigg
ol - a P a -
v
4 / N\
& | ﬁ.l
P b i
o R - “"x.\
/ N\ \
4 }‘_\"U \ b
E l\ / | I/'_' A\ ll,u'l
\, f/l LN /
\‘x,_____/__/ “-.‘\\,_h_ ol
Il" \
l 1
\ /
/
- i
= N &
£ »

v

Fil = FGE 000 Siishos = Thack e FEGE 01001 Liyen = Ly 1 4] o

122 AR N R N R R R A RGP e R A O N NG AP O E R S N R R E B D E EEE

Ml

2imed  [Dhiayer s

Again keep in mind when using common line cutting with plasma cutting the plasma can go out when
traveling over an already cut area. When cutting parts with holes the holes will need to be created
separately and cut order will have to be edited before cutting.
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Why when | create a tool path the original drawing is grouped with the tool path and I cannot
delete it?

In Torchmate CAD there is one default setting that must be changed to eliminate this problem. Go to
‘Options’ = ‘Torchmate Setup’ = ‘Tool Path Preferences’.
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Ensure that ‘Group tool paths with originals’ is unchecked. Press ‘OK’ and all future tool paths will be
created just fine.

Tool Path Preferences fXI

30 Chisel
" Single cut
+ Double cut

™ Group tool paths with originals

v Apply zeparately
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